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About this manual

Typographical conventions

This manual distinguishes between different types of information using the following conventions:

e Terms taken from the interface itself, such as commands, appear in bold.
e Key names appear in all caps. For example: "Press the SHIFT key."
e Numbered lists indicate that there is a procedure to follow.

e When the conjunction -or- appears next to a paragraph, it means there is the choice of another
procedure for carrying out a given task.

e When a menu command contains submenus, the menu name followed by the command to select

appears in bold. Thus, "Go to File > Open" means choose the File menu, then the Open command.

About your product

Some of the functions described in this manual may not be available in your product.

For the complete list of specific features available in your software, refer to the specification sheet provided with
the product.



Connecting to a database

Overview

In this chapter we are going to link a label (the container) with a database (the content). To do this, we will use
ODBC (Open DataBase Connectivity) or OLE DB connections.

Databases allow you to store data. All data is organized into two-dimensional tables in what is called a
relationship. Each row in a table is called a record. The purpose of a record is to manage an object, the properties

of which are organized across the different columns of the table in the form of fields.

A database can contain a number of tables. To link the different tables within a given database, we use joins. A

concrete example later in this chapter demonstrates how joins are created.

OoDBC

ODBC data sources make it possible to access data belonging to a wide range of database management
systems. ODBC makes it easy to link an application such as your label design software with a certain number of
databases. The software comes with several ODBC drivers. These enable you to access the most common types

of databases.

Some of the more common drivers are listed below:

e  Microsoft Access Driver (*.mdb)
e Microsoft Excel Driver (*.xIs)

e Microsoft FoxPro Driver (*.dbf), etc.

OLE DB

OLE DB is a set of interfaces that gives access to all data, regardless of type, format or location. It provides

components such as access interfaces, query drivers, and so on. These components are called "providers".

The example below describes a connection process when a database is not connected to your software.

Installing an ODBC data source

The process described below uses the direct creation mode. If you want, you can use the wizard by selecting

Wizard in the context menu.
Connecting to the TKTraining.mdb database

1. Inthe program, choose Tools > Administrator ODBC.
2. Click on the System Data Source tab (DSN), and then click Add.



Connecting to a database

Note: You can define data sources with system Data Sources Names (DSNs). These data sources are unique to a
specific computer but not to a specific user. Any user with the necessary rights can access a system DSN.

Select Microsoft Access Driver then click Finish.

Enter "TK Training Level 2" in the Data source name field.

Click Select and select the database TKTraining.mdb database, which can be found in the
InstallDinnSamples\Forms\Tutorial directory.

Click the Options button. Check the Read Only option. This option makes it possible to open the
database at the same time as your labelling software without causing any read/write problems.
Click OK in the ODBC Microsoft Excel Setup dialog box.

Importing data

After the database is connected to your software, you have to connect it to your document.

A

Open the PRODUCT_WS3 label.

Choose Data sources > Database > Create/Modify query.
Select TK Training Level 2 in the Select data source list.
Select "Fruits" in the Select table list.

The database fields appear in the Select fields list.

Select the "ProdName”, "Origin”, "Weight", and "Reference" fields.

A
Click the M button. It allows the selected records to be sorted into alphabetical or numeric order,
ascending, or descending.
Select "Reference" as the Sort Key and "Ascending"” as the Sort Order.
Save the query in the InstallDinSamples\Forms\Tutoria\PRODUCT_WS4_ODBC.CSQ directory.
Click OK.
The variables are created automatically and are listed in the Database branch in the Data sources view.

To view or print the different values that your object can take, use the navigation bar. You can also print from the

Query result window.

B | cHEmicAL v MMM ER = B

-

Creating variable objects

1.

2.

Select the created variables listed in the Database list in the Data sources view, then drag and drop it
into the workspace.
Select Text in the context menu.



Active Query Builder

Active Query Builder is a visual query builder component that allows you to build complex SQL queries using an
intuitive visual query building interface.

To work with Active Query Builder, you must have basic knowledge of SQL concepts. Active Query Builder will
help you to write correct SQL code hiding technical details, but you must have an understanding of the SQL

principles to achieve desired results.

Getting started

The main Active Query Builder window is divided into the following parts:

e The Query Building area is the main area where the visual representation of query will be displayed.
This area allows you to define source database objects and derived tables, define links between them
and configure properties of tables and links.

e The Columns pane is located below the Query Building area. It is used to perform all necessary
operations with query output columns and expressions. Here you can define field aliases, sorting and
grouping, and define criteria.

e The Query Tree pane is located at the right. Here you may browse your query and quickly locate any
part of it.

e The page control above the Query Building area will allow you to switch between the main query and
sub-queries.

e The small area in the corner of the Query Building area marked by the letter Q is the union sub-query

handling control. Here you can add new union sub-queries and perform all necessary operations.

&1 501 Query Builder...

-|aumu Expression foosgae  Jaiar  [SonTeps |So Order |Grounioa | Cieria Oe. Jor. o

)




Active Query Builder

Adding an object to the query

To add an object to the query, right-click the Query Building area and select the Add Object item in the drop-

down menu.

Add new object rz|
Select an object and prezs the "Add Object” button to add new object to the query

Filter objects by Schema name: ||{.ﬁ.ll objects) w |

B Tables |£|:'e| Yiews | 58 Procedures | Synonwms

@Categuries

ECustDmers

EEmplwees

EOrder Details

Eﬁrders

EPdeucts

Eﬁhippers

Eﬁuppliers

EE APPLICATION. DOCUMENT . CategoryID
EAPPLICF&TION.DOCUMENT.CategDryNamE
EF&F‘F‘LICF&TION.DOCUMENT.DESEriptiDn

Create links From Foreign keys

Close

The Add New Object window allows you to add multiple objects at once. The objects are grouped according to
their type in four tabs: Tables, Views, Procedures ( or Functions) and Synonyms. You may select one or
several objects by holding the CTRL key and then press the Add Object button to add these objects to the query.
You may repeat this operation several times. After you finish adding objects, click the Close button to hide this

window.

To remove an object from the query, select it and press the DELETE key or simply click the Close button in the

object header.

For those servers that have schemas or allow selection of objects from different databases, you can filter objects
by database or schema name by selecting the necessary schema or database from the combo box at the top of

the window.

Active Query Builder can establish links between tables based on information about foreign keys in the database.

This ability is turned on by default. To turn it off, clear the Create links from foreign keys checkbox.
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Editing object properties

You can change the properties of each object added to the query by right-clicking the object and selecting the

Edit option from the drop-down menu or simply by double-clicking the object header.

Datasource Properties

Obiject

00000000000y

Remove

ntactNar'rle
ContactTitle »/1d=!
Address

Aukofit Object Helght

(o | TRA

Region +/ice5!
PostalCode '/
Cooundry \/id=5 g
Phaone ]
Fax

|Eustomers

Aliaz

[ ok

][ Cancel ]

The Datasource Properties dialog may vary from server to server, but the Alias property is the same for all

database servers.

Joining tables

To create a link between two objects (i.e., join them), you should select the field to link the objects and drag it to

the corresponding field of the other object. After drag the field to the other object, a line connecting the linked

fields will appear.

M ain

I

Customers

CompanyMame "+ de5tng
ContactMame "/ ides tring
ContactTitle '/ideSting
Address wdeSinng
Citw "/ idesting
Reqion “/ide5ting
PastalCode "»/ideSting
Counbry 2025 nng
FPhone "/idestnng
Fax 'wideString

q

= Customers and Suppliers by City Epil
D =

City
CompanyM ame
ContactM ame
Relationzhip

I I [
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Active Query Builder

The default join type is INNER JOIN. This means that only matching records in both tables will be included in the

resulting dataset. To define other types of joins, right-click the link and select the Edit option in the drop down

menu or double-click it to open the Link Properties window. This window allows you to define join type and other

link properties.

Link Properties

Left object

3

Right object

|Cu3tomer$

| |Cu3tomer$ and Suppliers by City |

[]Select Al From Lett

Left columm

] Select All From Fright

Right colurmn

| Customerz. Customer| [

w |[Eu&tu:umers AMD Suppliers|

[ (]9 l’ Cancel ]

To remove a link between objects, right-click the link line and select the Remove option in the drop-down menu.

Sorting output fields

To sort of output query fields, use the Sort Type and Sort Order columns in the Columns Pane.

The Sort Type column allows you to specify the way the fields will be sorted, either in the Ascending or

Descending order.

The Sort Order column allows you to set up the order in which fields will be sorted if more than one field will be

used for sorting..

To disable sorting by a field, clear the Sort Type column for the field.

Defining criteria

| Dutpust |E:upr&ssim [.t’-‘-.gglagate IAIias |Sort Type |Su|t Order [Gmuphg [Erieria Or...
Customers. Customerl Ascending v 1 |
Customess Address 0

Ascending
Desceanding

To define criteria for the expression listed in the Columns Pane, use the Criteria column.

In this column, write the criterion omitting the expression itself. For example, to get the following criterion in your

query:

WHERE (field >= 10) AND (field <= 20)
you should write
>= 10 AND <= 20 in the Criteria column.

11
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You can specify several criteria for a single expression using the Or columns. These criteria will be concatenated

in the query using the OR operator.

Defining a parameterized query
Query Builder lets you create a parameterized query where the value of the parameter is held in a variable.
Note: You must have created a variable beforehand.
Drag and drop the table on which your query is to be carried out.
Select the field(s) to which the criterion or criteria is/are to apply.
In the Criteria column or in the SQL-format edit field, specify the variable to be used as the object of a
search criterion.
Example: To look for the value of the variable Var0O which you created beforehand:

e InSQL:

SELECT [Table].*
FROM [Table]
WHERE [Table].Champ = APPLICATION.DOCUMENT.VarO

e  Criterion column
= APPLICATION.DOCUMENT.Var0

4. Click to display the result of your query.

The Query result grid

To access the Query result grid, click the button in the Defining a query dialog box, in the Merge database
browser toolbar or via the Data sources > Database > View the query resulting data menu.

This grid allows the result of a query to be displayed and allows you to search for a particular term and all its

occurrences and print the corresponding labels.

The Query result grid contains:

e Search functions
Search field, which allows you to enter the field you want to search.

Data to search for, which allows you to enter the value to search for.

12



Active Query Builder
Search for the value anywhere in the field or at the start of the field |
Navigation functions for browsing query result records:
. i ]
First record *
. 4
Previous record **
&
Next record =+

]
Last record "

The results grid

Displays the search results.

Requery

Requery the request and update the grid.

13



Database Manager

Database Structure Window

= Database Manager

Database

5|

Connections

= | Mamne

~ Tupe

Database Structure

Table
| Frintlab |

| Length | Scale | Allownul |

Unigue

Database Quemy

[ | FIRSTMAME Varchar 25 v Ll
[ ] HAME Varchar 25 v [ ]
Database Structae  (ein i Varchar 25 vl O
[Ty Varchar 15 v []
[] STATE “archar z [w] []
ﬂ [laP Varchar 5 w| ]
|| LABMAME Warchar 50 k] L
Edit Databass [ | PRINTERMAME  Varchar 50 [] L]

[ [ ] SERIAL_OTY Lang v
|| LABEL_CPY long | 1 M [

i O

(=5 Addtable
[j’* Delete table
[ﬂ Wiew data
[ Apply
[ Cancel

The Database Structure window is used to manage the structure of the database file. From this window, you can

add, modify or delete tables/fields, etc.

Choose a database from the list of connections

1. Click the Database drop-down list.

2.

Select the required database.

Choose atable in a database

1.
2.

Click the Table drop-down list.

Select the required table.

14



Database Manager

Add atable to the active database

1. Click Add table.
2. Enter the name of the new table.
3. Click OK.

add table

Table Hame i Tops |

[] Duplicate with

Ok J ’ Cancel l

You can also copy the structure of the table from a table that already exists in the selected database. To copy a

table:
1. Select the Duplicate with check box.
2. Click on the drop-down list.
3. Select the required data.
4. Click OK.

Table Nare iTU.'r'31 |

Duplicate with [ IDENTITY v/

Delete a table in the active database

1. Click the Table drop-down list.
2. Click on the data required.
3. Click Delete table.

View/hide active table’s data

1. Click View data.
Define a key field
1. Select the check box next to the required field.

[
v

s

Ma

2. Click Apply.

15
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Define a field’s content type

1. Click the required field in the Type column.
Click the drop-down list button.
3. Select the required data.

4. Click Apply.

Define a field’s maximum size

1. Click the required field in the Length column.

2. Enter the value required.

3. Click Apply.

Allow an empty field

1. Select the Allow Null check box for the required field.
2. Click Apply.

Edit Database window

= Database Manager

File Wiew Taols

Edit Database

Databaze Table
Databagze iTo_l,ls v| iTDYS v|
Connectionz
| v =
e, . | | | =B0
- bt : PARTNU | NAME |LOTNOM | LOGONAME | SCALE | UNITSPERE

e T Trailar 533 failorbmp  1/100 50

(10570 Autobuz 100 autobuz.brp 1100 50

10580 Decker 1003 deckerbmp 14100 50
10750 Fiat-B e 1007 fiat.brp 1475 100
_ 232 Old 1024 old.bmp 1478 100
T |242m0 Gol 1005 golibmp 1475 100
24256 Lusuiry 1023 Isury. bmp 1475 100
243 Car-Red 1002 red.bmp 1475 100

.DDD | 24425 Truck-Fed 1025 truckRedbmp 1475 an

z | 24426 Truck-vel 1026 truckypelbrp  1/75 an
Database Query | 24580 Jeep 4xd 1011 |eep.bmp 1475 100
| 24536 Yan 1030 war. brmp 1475 100
| 247B6 Mercedes 1004 mercedes.bm 1475 100
= [ | 25103 Porsche 1002 porsche.brmp 1475 100

*
Print _
Fec: 4 = | 1 | | ] Mumber of records : 14




Database Manager

The Edit Database window is used to manage the contents of the database file. In this window, you can add,

modify, or delete data.

These actions depend on the type of database. Excel file records cannot be modified.

Select records according to their content

Use the content of a field to find a record.

Click the table drop-down list button.
Click the data required.
Click the Data Input field.

Enter the value required in the Data Input field.

L A

Select all identical records

At least one record must have been found.

Click the drop-down list button.

Click the data required.

Click the Data Input field.

Enter the required data in the Data Input field.

A w0 DD PR

5. Click the Select all button ().

Select an identical record

At least one record must have been found. There must be several identical records in the Search field.

Rec: 1= -llB - e

To select a record, use the search tool:

Create a new record

1. Click a field in the row marked with an asterisk.
2. Enter the values required in the corresponding fields.
3. Click Apply.

Modify a record

1. Click the data you want to modifiy.
2. Enter the required data .
3. Click Apply.

Delete arecord

1. Click the database cursor for the required field.
2. Right-click the database cursor for the required field.
3. Click Delete Record.

17
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Database Query window

= Database Manager

File i Tools

7

Database Query

Table
Database [TOvs ¥|
Connections .
Figlds l Filters ] SOL Query]
ﬁk_'_. Field selections
Database Structure AR Unused fields o e} Ordered fields
(1] [PARTHUM | Z  Ouew
= LOTNUM A
E LOGONAME
) SCALE
Edit Database UMITSPEREX
[e] | ,
Database Query — - — _ R —— |
FP&RTHLIM NAME LOTHUR LOGOMAME | SCALE | UNITSFERE | A
b | 24560 Jeep 4ud 1011 ieep.brap 1/75 100
| 10570 Autobus 100 autobus.bmp  1/100 50
10080 Trailar 999 trailor.brap 14100 50
: 10580 Decker 1003 deckerbmp 1100 50
it 110750 FiatBlue 1007 fiat.brp 1475 100
24200 Galf 1005 golf.bmp 1475 100
| 24766 Mercedes 1004 mercedesbm  1/75 100
24256 Lusury 1023 Iezury. brnp 1475 100
2z Oid 1024 ald.bmp 175 100
| 25108 Porsche 1002 porsche.bmp 175 100
2431 Car-Red 1002 red.brp 1/75 100
24425 Truck-Fed 1025 tuckRed.brp 1/75 an
28426 Truck-vel 1026 truckpelbrip 1475 an
Fec: a4 = | 1 | » »1 MNumber of records : 14

The Database Query window is used to create and apply various filters.

Add a query

1. Click Add query on the Fields tab.
2. Enter a name for the query.
3. Click OK.

Select/deselect one or more fields

o L JL e

1. Use
2. Click Query to refresh the database preview.

to select the required (fields).

Modify the order of fields selected

1. Click the required field in the Ordered fields window.
2. Click the up or down arrow to reorder the fields.
3. Click Query to refresh the database preview.

Create a filter using predefined data

1. Select the Filters tab.

18



Database Manager

| =5
Click the Add row button ( ).

In the Field field, select in the drop-down list the data required.

In the Operator field, select the desired operator from the drop-down list..

In the Value field, enter the required value .

S e

Click Query to view the result.

Apply alogical operator to several filters

| =5
Click the Add row button ( ).
In the Logical field, select the desired logic (AND or OR) from the drop down list..

Create a filter (as described above).

WD PR

Click Query to view the result.

Remove afilter

Note: At least one filter must exist.

1. Click the database cursor for the required field.

&

2. Click the Delete row button ( ).

Modify a filter in SQL

Note: At least one filter must exist.

1. Selectthe SQL Query tab.
2. Check Modify the query in SQL language to activate the SQL Query and make manual changes.

3. Click Query to view the result.

The Print window

EEX

= Database Manager.

File: Wigw Tools
==
-. 3 Database Table Query
D atabase _ | ﬂ i TOVS . : 'DDD \ toys1 » |
Cornections -
B’ | VI ‘ | 1?;3' [~ |Z] E] % I% e = Settings
Databahucm [Quarty | NAME LOGONAME | PARTMUM |LOTMUM | UNITSPERE FrTTEET—
| |0 Jeep 4xd ieep.bmp 24560 1011 100
; a Autobus autobuz.brmp 10570 100 50 Ill Designer
| |0 Trailar trailor. bmp 10080 933 50
=3 o Decker deckerbmp 10560 1009 50
: ] Fiat-Blue fiat.brp 10750 1007 100
Edit D atabase [ o Galf ol bmp 24200 1005 100
: ] Mercedes mercedesbm 24766 1004 100
: a Lvssury Iy brp 24256 1023 100
.DDD ; ] oid old.brp 23z 1024 100
- | |0 Porsche porsche.bmp 25108 1002 100
D atabase Quemy : il Car-Red red.brp 24321 1002 100
: il Truck-Hed tuckRedbm 24425 1025 a0
: a Truck-vel tuckyelbrp 24426 1026 a0
) : 1] an van.bmp 24596 1030 100
Number of records : 14
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The Print window is used to select files for printing, assign printers, and define various parameters before printing

is launched.

Select a document to be printed

1. Select a document from a file

2. Select the File check box in the Label name group.

_Or-

il
Click the Label Creation Wizard button ().

2. Follow the on screen instructions.

Note: Creating a label in relation to the database allows you to define exactly which elements are required to position each

database field.

Select an existing label template

1. Click the Open an existing document button (@).
2. Select a .lab file.
3. Click OK.

Note: The Field radio buttons in the Label name and Printer name groups of options allow you to choose the required label or

printer, when these options are defined in one of the fields of the active database.

Select a document from a field

If your database contains the name of the label to be used for the printing job in one of the fields, you can define
this field as the location where Database Manager is going to pick up the .lab .Ibl file. For example, consider the

following database:

Ref Designation Qt Code Labname
6574 Refl 1 9876546321 Labell.lab
6354 Ref2 2 1236478855 Label2.lab
6987 Ref3 3 6987456321 Labell.lab
3684 Ref4 4 3698745632 Label3.lab

1. Check Field box in the Label name group.
2. Select the required field .

Select a printer

1. Click onthe Add or Remove a printer button ().

2. Select the required printer.
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The Formula data source

Command: Data sources > Formula > Add
The Formula data source contains a list of data sources.

These data sources are populated by combinations of operators, constants, data sources, control variables,

formulas, and functions. Data can be numeric or alphanumeric.
In order to carry out a calculation within a document, you must first create a Formula data source.

This data source has a specific dialog box allowing you to define the required function(s) for a given formula.

About functions

Functions are predefined formulas that carry out calculations by using values called arguments, placed in a
certain order, called syntax.

Functions are used to return a numeric, character string, or logical value, which is the result of a calculation or an

operation.

There are six groups of functions in the formula definition:

e  Check character calculation functions

e  Conversion functions

e Date and time functions

e Logical functions

e Mathematical functions

e  Text/Character string functions

Operators

Operators are mathematical symbols indicating an operation to be carried out. There are different types of
operators: arithmetic, comparative, concatenation, and logical.

The program contains mathematical, comparative, concatenation, and logical operators.

Arithmetic operators

Operator Used

* Multiply two numbers.
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+ Add two numbers together.

= Subtract one number from another, or assign a negative value to an operand.

/ Divide one number by another.
A Raise a number to the power of the exponent.
% Modulo.

Comparative operators

< Less than.

<= Less than or equal to.

> Greater than.

>= Greater than or equal to.
= Equal to.

<> Different from.

Concatenation operator

Used to combine two strings.

Operator Meaning

& Concatenation of two strings.

Logical operator

(See also Logical Functions)

Operator Meaning

! Not logical.

Check character calculation functions

addmodulo10 («string»): Returns the integer with the Modulo 10 check character added to the end.

addmodulo10_2 («string»): Returns the integer with a variant of the Modulo 10 check character added to the
end.

addmodulo10_212(«string»): Returns a modulo 10_212 check character (a variant of the standard modulo 10

check character), and includes the current text string and the checksum at the end of the string.

addmodulo43(«string»): Returns a modulo 43 check character and includes the current text string and the

checksum at the end of the string.

bimodulo 11 («string»): Returns the two modulo 11 check characters (Code 11).
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canadacustomscd («string»): Returns the Canada Customs Standard check character.

Check103(«string»): Calculates Mod103 checksum.

check 128 («string»): Returns the Code 128 and EAN-128 check character.

Check PZN(«string>): Calculates check digit for PZN barcode. PZN barcode is based on Code 39

used for pharmaceutical products in Germany.

CheckSumMod10(«string»): Calculates Mod10 checksum.

CheckSumMod10_Codabar(«string»): Calculates specific Mod10 checksum for Codabar.

CheckSumMod10_MSI(«string»): Calculates Mod10 checksum for MSI barcode.

CheckSumMod11_3Suisse(«string»): Calculates Mod10 checksum for 3Suisses.

CheckSumMod34(«string»): Calculates Mod34 checksum.

CheckSum2Mod47(«string»): Calculates Mod47 checksum.

checkupce («string»): Returns the check character for UPC-E (6 mandatory characters).

modulo 10 («string»): Returns a modulo 10 check character of Code 2 of 5 interlaced, EAN-13, EAN-8, EAN-128
K-Mart, VPCA.

modulo10_212(«string»): Returns a modulo 10 check character variant.

modulo10IBM(«string»): Returns an IBM modulo 10 check character (a variant of the standard modulo 10 check

character).

modulo 11 («string»): Returns a modulo 11 (code 11) check character.

modulo11IBM(«string»): Returns an IBM modulo 11 check character (a variant of the standard modulo 11 check

character).

modulol6( string ): Returns the modulo 16 check digit

modulo 24 («string»): Returns a modulo 24 (Code PSA) check character.

modulo 32 («string»): Returns a modulo 32 (ltalian pharmaceutical industry) check character.

modulo 43 («string»): Returns a modulo 43 (code 39) check character.

modulo 47 («string»): Returns two modulo 47 (Code 93) check characters.

Plessey («string»): Gives two check characters (Plessey Code).
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pricecd («string»): Returns 4 UPC Random Price check characters.

pricecd5 («string»): Returns 5 UPC Random Price check characters.

StringToExt39(«string»): Prepares string to be used in Extended 39 barcode.

UPSCheckDigit («string»): Returns the UPS check characters. The input for the method is a string. This method

leaves the rest of the tracking number up to you. It takes a 15 character sequence, and calculates the check digit

using this sequence.

The first two characters must be "1Z".
The next 6 characters we fill with our UPS account number "XXXXXX".
The next 2 characters denote the service type:
e  "01" for Next Day Air shipments.
e "02" for Second Day Air shipments.
e "03" for Ground shipments.
The next 5 characters is our invoice number (our invoices are 6 digits; we drop the first digit, e.g., the
123456 invoice would yield 23456 characters).
The next 2 digits is the package number, zero filled. E.g., package 1 is "01", 2 is "02".

The last and final character is the check digit.

Note: The described sequence above gives 17 characters, where as only need 15 are needed to calculate the check digit. To

do this, drop the "1Z" portion, and only use the last 15 characters in the method.

Conversion functions

ASCII («string»): Returns the ASCII code of the first character in the string argument.

Example:

ascii("A") = 65

char («integer»):

For values from 128 to 255: Gives the character corresponding to the integer argument in the ASCII
table.
For all negative values and values from 0 to 127 and greater than 255: Returns the Unicode character

corresponding to the integer argument.

Example:

char (65) = "A"

CodabarData(«data», «start», «stop»): Adjusts data for CodabarData.

Codel28CData(«string»): Adjusts data for Code 128 C.

CRC16(«string»): Returns CRC-16 value.

24



Formulas

Examples:
CRC16("123456789") = 47933
"Ox" & hex(CRC16("123456789"), 4) = 0xBB3D
Currencytoeuro («value»): Converts the current national currency into Euros.

DatabarData(«data», «min», «<max», «khasComposite»): Adjusts data for DatabarData.

DBCSToUnicode(«string»,«codepage»): The formula takes two parameters - the data «string» to be
converted, and the Codepage «codepage» used. The Codepage parameter is represented by the language
name (Thai, Japanese, ChineseGBK, Korean, ChineseBig5, European, Eastern, Cyrillic, Greek, Turkish, Hebrew,
Arabic, Baltic, Viethamese, UTF-8, ACP) or numeric value (search code page identifiers documentation on

Internet).

Example:
DBCSToUnicode(unicodetoDBCS("f# {# {7 {#%", "UTF-8"), "UTF-8") =f& 5 {5 {5

This function is needed for data that come from non-Unicode file or data sources (e.g. Database).
Note: This function has reverse action to UnicodeToDBCS method.

dollar («value»): Modifies a field to represent a price.

Example:
If a field named PRICE displays a value of 199, then:
dollar(PRICE) will display $199.00.

Eurotocurrency («value»): Converts the Euro into the national currency.

Note: The number of decimals to be displayed must be defined in the Output tab of the Formula data source by checking the

Display decimals field. The conversion rate used is the one defined in the Others tab of the Options dialog box.
FileToData(«fileName», «errorData», «maxSize»): Returns the data read from the file.

fixed («value» , «cnum_decimals», «xnon_sep»): Returns a string of formatted characters with a number of
decimals equal to num_decimals and with or without a thousands separator.

Examples:
fixed (1234.5678, 3, TRUE) = "1234.568"

fixed (1234.5678, 3, FALSE) = "1,234.568"

Note: The thousands separator to be displayed must be defined in the Output tab of the Formula data source by checking the

Display decimals box.
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FormatDate(«date», «dateFormat», «localelD»): Converts «date» to a string formatted according to

«dateFormat».

Return String A date value in string format, formatted according to a format.

value

date String Date value in string format.

dateFormat | String/ Format of the base date value.

Number - Numbers encode predefined formats. (For example, 1"dd/mm", 2 "dd mmmm"

and so on). Possible values are available here.
- 0 or negative values mean using the current system date format.
- String value encode the format directly. (For example, "yyyy/mm/dd")

LocalelD Number Locale used to show the date value. LocalelD is optional (Default: 0, system locale
will be used). Possible values (number) can be found on
http://msdn.microsoft.com/en-us/goglobal/bh964664.aspx.

FormatMoney(«amount», «use separation characters(T/F)», «price characters», «force leading zero (T/F)»,

«location for price character», «# of decimal places»)

Allows you to add currency symbol, dots, force leading zero, use separation characters

Example:

FormatMoney("123456.234", "T","$","F",0,2) = $123,456.23
FormatMoney("1234","F","$","T",8,2) = $1234.00

FormatMoney("0.234","F","$","F",0,2) = $.23
FormatMoney("0.234","F","$","T",0,2) = $0.23

Note: Location for price character is responsible for price character position, spaces are added between

price character and amount . This value is ignored if it is less than result string length.

GetEnv(«name»): Returns the value «xname» (string) of environment variable.

Example:

GetEnv("OS") =" Windows_NT".

Note: This function works with user defined environment variables

GS1AlData(«AlName», «AlData», «isLastAl»): Adjusts data for GS1 Al.

int («value»): Returns the largest integer less than or equal to the value argument.

Examples:
int (-5.863) = -6
int (5.863) =5
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LmcChar («integer») : Returns the character corresponding to the integer argument in the ANSI table. This table
does not depend on the locale system.
Value is between 0 and 255.

MaxiCodeData(«Mode»,«PostalCodex»,«CountryCode»,«ClassOfService»,«TrackingNumber»,«UpsShipper
Number»,«JulianDate»,«ShipmentID»,«PackageNumber»,«TotalPackages»,«PackageWeight»,«AdressVali
dation»,«ShipToAdress»,«ShipToCity»,«ShipToState»): Creates a maxicode data from input «string».

Output («variable»): Returns the formatted value of the variable.

Example:
Counter0 has the prefix "number:". The formula "counterO has a value of " & counter0 & " and a formatted

value of " & output(CounterQ) gives the result : counter0O has a value of 1 and a formatted value of

number:1

Note: The variable formatting is defined in the Output tab.

round («val_1», «val_2»): Returns the argument val_1 rounded to the number of figures indicated by val_2.

If val_2 is greater than 0, val_1 is rounded to the number of decimals indicated.

If val_2 is equal to 0, val_1 is rounded to the closest integer.

If val_2 is less than 0, val_1 is rounded off to the left of the decimal point.

Examples:
round(4.25,1) = 4.3

round(1.449,1)=1.4
round(2.479,2) = 2.48
round( 42.6,-1) = 40
round(45.6,-1) = 50

text («value», «format»): Returns the value argument written in the format imposed by the format argument,

which corresponds to the format described in the explanation of the When Printed variable.

Examples:
text (012345678, "##H-#t-#HH") = 012-24-5678

text (2125551212, " (#H#H)HiH-HH##") = (212)555-1212

Example:
text (12 , "~~~~") = 0012

where "~" is replaced by 0 in result value if the input value length is less then format length.

Example:
text (12, ") or text (12 , "###H") = 12

where "*" and "#" are the special symbols replaced by data.
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trunc («value»): Returns the integer part of the value argument.

Example:

trunc (123.45) =123

value («string»): Gives the numeric value of a character string.

Example:
value("123") = 123

value("0.00:48:00")-value("12:00:00") equals "16:48:00"-"12:00:00" equals 0.00, the serial number for 4

hours and 48 minutes.

Note: It is not usually necessary to use the value function in a formula, since the application automatically converts the text to

numbers if necessary.

UnicodetoDBCS(«string_1», «string_2») : The formula takes two parameters - the data «string_1» to be

converted, and the Codepage «string_2» used. The Codepage parameter can have any of the following as a

value:

Thai
Japanese
Chinese GBK
Korean

Chinese Big5

European eastern

Greek
Turkish
Hebrew
Arabic
Baltic

Vietnamese

Note: The Codepage parameter is not case sensitive.

ValueEx(«string»): Converts «string» into a numerical value.

VoiceCode(«string», «string», «string»): A VoiceCode is a 4 digit number computed using the GTIN, Lot, and

optional Date from a PTI.

Return value

string

Calculates a VoiceCode value.

GTIN

string

14 digit GTIN number. Only digits are allowed. Error will be
returned in case of non-digit value. Left part 14 digits are
accepted in case data length is more then 14. '0' are added to the

left in case data length is less than 14 digits.
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LotNumber string Up to 20 alphanumeric symbols data. Left part 20 symbols are
accepted in case data length is more than 20 digits.
Date string This is an optional parameter. 6 digits data that represents the

date in YYMMDD format. Formula returns error in case of wrong

length, non-digit value or wrong date.

This computation is performed as follows:

1. Compute PlainText.

2. Compute ANSI CRC-16 Hash of the PlainText ASCII bytes using the standard ANSI CRC-16 hash with

a. PlainText is the 14 digit GTIN appended by the Lot Code and the Date (where present).

b. Do not include the application identifier prefixes or parentheses.

c. There are no spaces between the GTIN, Lot and Date fields.

d. Date if present is represented as YYMMDD with zero packing and no '/' characters.

the polynomial of X16 + X15 + X2 + 1

See CRC-16 function.
3. Compute the VoiceCode by from the Hash by taking the 4 least significant digits in decimal form (Hash

mod 10000).

Example:

GTIN = (01) 10850510002011
Lot = (10) 46587443HG234

PlainText = 1085051000201146587443HG234

CRC-16 Hash = 26359

VoiceCode = 6359
Large Digits = 59
Small Digits = 63

Examples:

VoiceCode("10850510002011", "46587443HG234") = 6359
VoiceCode("65457886676767", "2", "100126") = 5836
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Date and time functions

The date variable represents the system date and time, and not the date variable defined by the program:

Note: 30/12/1899 = your application’s reference date. If you want the formula to return the current date, the solution is to
calculate the number of days elapsed since the reference date.

day («date»): Gives the day of the month of the date argument.

hour («date»): Gives the hour of the date argument.

minute («date»): Gives the minutes of the date argument.

month («date»): Gives the month of the date argument.

now (): Gives the current date and time.

second («date»): Gives the second of the date argument.

today (): Gives the current date.

weekday («date»): Returns the day of the week from the date argument.

Note: Sunday is considered the first day of the week.

Example:
On "Tuesday November 20, 1999" the weekday(now()) = 3

Week («date»): Returns the number of the week from the date argument.

Year («date»): Gives the year of the date argument.

Example:
Minute (now()) gives the current hour and minutes.

Year (today()) gives the year of the current date.

Note: For Minute and Hour, only the now() argument is allowed. For all other functions, now() and today() are allowed.

BestBefore («date» , «dateFormat» , «offset» , «offsetUnit» , «xchangeMonth» , «outputFormat»,
«localelD»)

Allows you to calculate a Best Before date based on keyboard input value (not based on current date).

Return value String A date value in string format, calculated by a base date and an offset.

date String Base date value in string format.
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dateFormat String / Format of the base date value.

Number - Numbers encode predefined formats. (For example, 1"dd/mm", 2 "dd
mmmm" and so on). Possible values are available here.

- 0 or negative values mean using the current system date format.

- String value encode the format directly. (For example, "yyyy/mm/dd")

offset Number Number of date units to be added to the base date.
offsetUnit String / Meaning of the offset parameter.
Number -1 or"d" or "D" means days.

- 2 or "m" or "M" means months.

-3 or"y" or "Y" means years.

changeMonth | Number Optional (Default: True)

- 0 means False.

- 1 means True.

If calculated date does not exist in the month (For example, 30 of February).
True return the first day in the next month (For example, 1st March).

False return the last day in the current month (For example, 28 of February).

outputFormat | String / Optional (Default: same as dateFormat)
Number This parameter specifies the output format of the calculated date.

Possible values are available here.

localelD Number Optional (Default: 0, system locale will be used)

This parameter specifies the locale used to show the date value.

Example:
BestBefore("14/06/2012" ,"dd/mm/yyyy","18","m", 1, "mmmm dd, yyyy", 1033) will return December 14,

2013.
BestBefore("14/06/2012" ,"dd/mm/yyyy","18","m", 1, "mmmm dd, yyyy", 1036) will return Décembre 14,
2013.

Example: Formula with a date data source.
Create a date variable name date0O with the date of the day, for example 26/06/2012 (dd/mm/yy format).

BestBefore(dateO ,"dd/mm/yy","18","m", 1, "dd/mm/yyyy") will return 14/12/2013.

DateValue( «formattedDate », «dateformat» )

Return value Date Returns a date value of the formattedDate parameter.
formattedDate String A text format date, to be converted to a date value.
dateformat String Optional (Default: the system date format)

If specified, the direct format string. For example, "dd/mm/yy"

Example:
DateValue(22062012,"ddmmyyyy") will return 22/06/2012.
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DateOffset( «date» , «offset», «offsetUnit» , «xchangeMonth»)

Return value Date Adds a date interval to the specified base date.
date Date Base date value.
offset Number Number of date units to be added to the base date.
offsetUnit String / Meaning of the offset parameter.

Number -1 or"d" or "D" means days.

- 2 or "m" or "M" means months.

-3 or"y" or "Y" means years.

changeMonth Number Optional (Default: True)

- 0 means False.
- 1 means True.
If calculated date does not exist in the month (for example, 30 of February).

True return the first day in the next month (for example, 1st March).

False return the last day in the current month (for example, 28 of February).

Example:
DateOffset("26/06/2012",1,"d",1) will return 27/06/2012

-OR-
DateOffset(today(),1,"D", 0)

Example: Formula with a date data source.
Create a date variable name DateO with the date of the day, for example 26/06/2012. You
should ensure that date variable is in default system format (otherwise you can use

DateValue() function to get the date value from the date variable).

DateOffset(Date0,1,"D", 0) will return 27/06/2012

FiscalDate(«fiscalStartDate», «outputFormat»)

Allows you to calculate the date for the start of your fiscal year (yyyy.mm.dd).

Examples (if current date is 2009.11.24):

FiscalDate("2009.01.01", 1) = 09
FiscalDate("2009.01.01", "yyyy") = 2009
FiscalDate("2009.01.01", 3) = 47
FiscalDate("2009.01.01", "day") = 328

shiftcode(«items», «defaultValue»)

The Shift code is used as a data source for a field on the label that needs to change based upon the current time.

A shift represents a span of time that is defined and named.
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Return value String

Returns the current shift code value.

items String

Shift code items in the following format: startHour:startMin-

stopHour:StopMin-value|...| startHour:startMin-stopHour:StopMin-value

For example, shifts could be defined as follows:

e 7:00to 15:00 = Day
e 15:00 to 23:00 = Evening
e  23:00to 7:00 = Night

Notes:

1. The 24-hour clock is used to define time values. 0:00 is midnight; 12:00 is midday.

2. If there are any time overlaps in input then the first acceptable value is returned.

3. If there is no shift for the current time then an empty string is returned.

Example (if current time is 16:00):

shiftcode("7:00-15:00-Day|15:00-23:00-Evening|23:00-7:00-Night","Day") ="Evening"

SpecificDateFormat("[date format]", "+/[offset data][date interval]")

Allows you to customize a date stamp by offsetting the date by a certain interval and use this customized date in a

formula expression. The SpecificDateFormat function offsets the current date based on the system clock using

either the default date format or a different format of your choosing.

e [date format] Specifies the date format to use. This parameter must be enclosed within parentheses.

View table of valid date formats.

Date Setting Output
Dandd 1

DD 01

dd 1
DDD 224
ddd 224
DDDDD and ddddd 33482
W and w 1

ww 34
ww 34
WWW and www 783
WWWW and wwww 4783
WWWWWWWWW

WWWWWWWWW 4783
M and m 9

MM 09
mm 9

000004783

Description
date of month (non lead zero)

2 char date of month (lead zero)

2 char date of month (lead space)

days from begin of year (lead zero)

days from begin of year (lead space)

days from 1/1/1900 (5 to 9 chars available)

day of week (Sun=1, Sat=7)
weeks from begin of year (lead zero)

weeks from begin of year (lead space)
weeks from 1/1/1900 (last 3 digits)

weeks from 1/1/1900 (4 to 9 chars available)
weeks from 1/1/1900 (lead zero)

weeks from 1/1/1900 (lead space)

month digit (non lead zero)
2 char month digit (lead zero)

2 char month digit (lead space)
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MMM

mmm
MMMM and mmmm
MMMMM

mmmmm

MMMMMMMMM

mmmmmmmmm

YY and yy
Y and y

YYY and yyy

YYYYYYYYY
YYYYYYYYY

009

9
1101
01101

1101

000001101

1101

91
1991

991

000001991
1991

3 char month digit (lead zero)
3 char month digit (lead space)

months since 1/1/1900
5 char months from 1900 (lead zero)

5 char months from 1900 (lead space) (5to 9
chars available)

9 char months from 1900 (lead zero)
9 char months from 1900 (lead space)

2 digit year
full year

last 3 digits of year (3 to 9 chars available)

full year (leading zero)
full year (leading space)

+/[offset data] This value specifies the amount by which to offset the date. The interval must be preceded

by either a plus (+) or minus () sign, depending on if you want to add or subtract from the current date.

[date interval] The date interval must be either d for days, w for weeks, m for months, or y for years.

Examples of the SpecificDateFormat function used in expressions in different formats:

Note: For these examples, assume the current date is July 29, 2013.

SpecificDateFormat( "mm dd yy" , "+1y" ) = 7 29 14 (1 year after the current date)

SpecificDateFormat( "ww/m/yyyy" , "30w) = 1/12/2012 (30 weeks before the current date)

SpecificDateFormat( "ddddd / wwww /mmmm" , "™ ) = 41484/5928/1363 (days, weeks and months since

1900)

TimeOffset(FormatDate(Now(), "mm/dd/yyyy hh:nn:ss"),"time interval +/offset time")

The TimeOffset function allows you to customize a time stamp by offsetting the time by a certain interval and use

this customized time in a formula expression. The TimeOffset function offsets the current time based on the

system clock using the default time format.

When used in an expression, the TimeOffset function must be written using the following parameters:

You can use only the default format of "mm/dd/yyyy hh:nn:ss". To enter a different format you need to

wrap TimeOffset with the DateValue function and then wrap into FormatDate function where you can

specify other time format.

“+/offset time” This value specifies the amount by which to offset the time. The offset must be preceded

by either a plus (+) or minus () sign, depending on if you want to add or subtract from the current time.

"time interval" The time interval must be either s for seconds, m for minutes, or h for hours.

The following table shows examples of the TimeOffset function used in expressions in different formats. (Note:

For these examples, assume the current time is 4:12:10 PM on July 30, 2013)
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TimeOffset(FormatDate(Now(), "mm/dd/yyyy hh:nn:ss"),"h+5") = 07/30/2013 21:12:10 (5 hours after the

current time)
FormatDate(DateValue(TimeOffset(FormatDate(Now(), "mm/dd/yyyy hh:nn:ss"), "h+10"), "mm/dd/yyyy
hh:nn:ss"), "hhnn") = 16-22 (10 minutes after the current time)

Weekl|S08601(«Date», «DateFormat»)

Allows you to create a formula that support the ISO8601. ISO 8601 is an international standard covering the

exchange of date and time-related data.

Return value date Returns the week of the specified date
Date string A text format date, to be converted to a date value.
DateFormat string Format of the base date value.

- Numbers encode predefined formats.

(e.g. 1 dd/mmlyy, 2 dd/mm/yyyy and so on

- 0 or negative values means using the current system
date format

- String value encode the format directly. (e.g.
"yyyy/mm/dd")

Example:

WeeklSO8601(" 03/01/2010 ",0) = 53
WeeklSO8601(" 02/01/2011 "," dd/mml/yyyy ") = 52
WeeklSO8601(" 01/01/2011 ", " dd/mm/yyyy ") = 52

Logical functions
Logical functions allow you to check whether one or more conditions have been fulfilled.

Note: TRUE equals 1 and FALSE equals 0.

and («expr_1», «expr_2»): Returns TRUE if both arguments are true, FALSE if at least one is false. The

arguments must be calculated from logical values.

Example:
and(exact("string","string"),exact("string","string")) = 0

and(exact("string","string"),exact("string","string")) = 1

exact («string_1», «string_2»): Returns TRUE if the two strings are identical, FALSE if not. This function is

case-sensitive.
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Example:
exact("software","software") = 1

exact("software","software"”) = 0

if («expr», «Val_if_true», «Val_if_false»): Returns the Val_if_true value if Expr is true and the Val_if_false
argument if Expr is false.

Example:
if(exact("string”, "string"), "true", "false") = false

if(exact("string", "string"), "true", "false”) = true
not («logical»): Gives the opposite of the logical argument.

Example:

not(exact("string", "string")) = 1
not(exact("string", "string")) =0
not(False) =1 or not(0) = 1
not(True) =0 or not(1) =0

not(1+1=2) =0

or («expr_1», «expr_2»): Returns TRUE if one of the two arguments is true and FALSE if both arguments are

false. The arguments must be calculated from logical values.

Example:

or(exact("string", "string"),exact("string", "string")) = 0
or(exact("string", "string"),exact("string", "string")) = 1
or(true,true) =1 oror(1,1) =1

or(true,false) =1 oror(1,0) =1

or(false,false)= 0 or or(0,0) =0

Mathematical functions

Abs(data): Returns the absolute (positive) value of data.

Examples:
Abs(-5) =5
Abs(5) =5

baselOtobaseX(«string_1»,«string_2»): Converts string_2 from base 10 to base string_1.

Examples:

If the field named Base 16 contains the string "0123456789ABCDEF"
BASE10TOBASEX(Basel6, 12) produces C
BASE10TOBASEX(Basel16,10) produces A
BASE10TOBASEX("012345","9") produces 13
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Note: This formula cannot accept negative decimal numbers for string_2 parameter.

baseXtobaselO(«string_1»,«string_2»): Converts string_2 from base string_1 to base 10.

Examples:
If the field named Base 16 contains the string "0123456789ABCDEF"

BASEXTOBASE10(Basel6, "E") produces 14
BASEXTOBASE10(Base16,10) produces A
BASEXTOBASE10("012345","9") produces 13

Ceil(data): Rounds data up to the next whole number.

Example:
Ceil(3.234) =4
Ceil(7.328) = 8

Decimals(datal, data2): Uses data2 decimal places in datal.

Example:
Decimals(4, 2) =4.00
Decimals(3.524, 1) = 3.5

eval_add(«string»,«string»): Returns the sum of parameters.

Example:
eval_add(5,5)=10

eval_div(«string»,«string»):Returns the division of parameters.

Example:
eval_div(20,2)=10

eval_mult(«string»,«string»): Returns the multiplication of parameters.

Example:
eval_mult(5,2)=10

eval_sub(«string»,«string»): Returns the substraction of parameters.

Example:
eval_sub(20,10)=10

Floor(data): This function rounds data down to the next whole number.

Example:
Floor(3.234)= 3

Floor(7.328)=7

Formulas
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hex(«val_1»,«val_2»): Converts the val_1 decimal number to hexadecimal format with a total value of val_2.

Note: This formula cannot accept negative decimal numbers for val_1 parameter.

Example:
hex(2, 8) = 00000002

int («value»): Returns the largest integer less than or equal to the value argument.

Examples:
int (-5.863) = -6
int (5.863) =5

max(datal, data2, ...): Displays the largest value in the data series.

Example:
Max(5, 12.3) = 12.3

min(datal, data2, ...): Displays the lowest value in the data series.

Example:
Min(5, 12.3) =5

mod («val_1», «val_2»): Returns the remainder of the division of the val_1 argument by the val_2 argument. The
result has the same sign as the divisor.

Examples:

mod (7,2) =1
mod (-7,2) =-1
mod (7,-2) =1
mod (-7,-2) = -1

guotient («val_1», «val_2»): Returns the integer result of the division of the val_1 argument by the val_2

argument.

Example:
quotient(10, 2) =5

round («val_1», «val_2»): Returns the argument val_1 rounded to the number of figures indicated by val_2.

e Ifval_2is greater than O, val_1 is rounded to the number of decimals indicated.
e Ifval_2isequalto 0, val 1 is rounded to the closest integer.

e Ifval_2islessthan 0, val_1 is rounded off to the left of the decimal point.

Examples:
round (4.25,1) = 4.3
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round (1.449,1)=14
round (42.6,-1) = 40

trunc («value»): Returns the integer part of the value argument.

Example:
trunc(10.0001) = 10

Text functions

A character string can be assimilated into a table if each fields contains a character. It is defined by its length
(total number of characters in the string, including spaces). The position of a character in the string corresponds
to its place in the table. For example, the first character is at position one, position 3 corresponds to the third

character in the string.

Al253(«string»): Specific function for preparing string for application identifier 253.

Al8003(«string»): Specific function for preparing string for application identifier 8003.

cyclebasex (): Allows counting to take place in any kind of database counting system. The numbering system
must be defined within the linked expression. The start value, the value of each increment and the number of
copies must also be specified for each number. All these values can be linked to other fields in the label, but the

field names must not be enclosed in quotation marks.

Example:

If a field named Base 16 contains the character string 0123456789ABCDEF, then:
cyclebasex(basel6, "8",1,1) = 8,9,A,B,C

cyclebasex(basels, "F", -1,1) = F,E,D,C,B,A 9,8,7

cyclebasex(basel6, "BO ", 1,1) = BO, B1, B2

cyclebasex("012345", "4",1,2) = 4,4,5,5,10,10,11,11

cyclechar (): Creates a user-defined set of characters for a complete cycle.

Examples:
cyclechar("A","C"Y=ABCABCABC

cyclechar("A", "C", 1,2)=AABBCCAABB

cyclenumber (): Allows you to set your own sequence of numbers, instead of using the normal sequence of
numbers or letters (0,1,2; or A,B,C).

Examples:

cyclenumber(1,3) will produce labels in the following sequence: 12312312 3...

cyclenumber(1,3,1,2) will produce labels in the following sequence: 1,1,2,2,3,3,1,1,2,2,3,3,1,1...
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cyclestring (): Allows you to create a group of words or characters using a complete cycle as an increment field.

The whole string must be enclosed in quotation marks (" ") and each word or group of characters must be

separated from the others by a semicolon ( ;).

Example:

cyclestring("Mon ; Tue ; Wed ; Thu ; Fri ; Sat ; Sun") = Mon Tue Wed Thu Fri Sat Sun
The following example is for labels that use all letters of the alphabet except for O and I.
cyclestring("A;B;C;D;E;F;G;H;J;K;L;M;N;P;Q;R;ST;U;V;W; X;Y;Z")

exact («string_1», «string_2»): Returns TRUE if the two strings are identical, FALSE if not.

Examples:
exact("software","software”) = 1

exact("sftware","software") = 0

extract («string», «sep», «pos»): Returns the substring from the character string «string» at the specified

position «pos» that contains data separated by string «sep».

Example:
Extract('1;2;3;4",",",3) =3

find («string», «key», «start»): Returns the position of the first occurrence of the key argument in the string

argument. The search in the string argument starts from the position returned by the start argument (start >= 1).

The function resets to zero if no occurrence of the key argument is found. The function distinguishes between
upper and lower case letters.

Example:
find("Peter McPeepert","P",1) = 1
find("Peter McPeepert","p",1) = 12

FormatNumber(number): Allows you to format a numeric field where a pound sign (#) means only display if a

value is there and zero (0) means always display.

Examples:
FormatNumber(123.45, "US$ #,###,###.00™) = US$ 123.45

FormatNumber(123.45, "US$ 0,000,000.00") = US$ 0,000,123.45
FormatNumber(.45, "#,##0.00") = 0.45

FormatNumber(.45, "#,###.00") = 45

FormatNumber(7188302335, "(###) ###-#E###") = (718) 830-2335
FormatNumber(123.45, "00.00") = 23.45

FormatNumber(123.567, "###,##0.00") = 123.57

left («string», «num_char»): Returns the character string extracted from the string argument. This string starts at

position one of the string argument and has a length equal to the num_char argument.
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Example:
left("Peter McPeepert",1) = P

left("Peter McPeepert ",5) = Peter

LTrim(«string»): Will automatically trim off any trailing spaces or leading spaces to the left data.

Example:
LTrim(" No."): No

len («string»): Gives the length of the string argument. Spaces are counted as characters.

Example:
len("Paris, New York") = 15

len("™ =0
len("") =1

lower («string»): Converts all upper case letters in a text string into lower case letters.

Example:
lower("Paris, New York") = paris, new york

mid («string», «start», «xnum_char»): Returns the character string extracted from the string argument. This
string starts at the position corresponding to the value of the start argument (start >=1) and has a length equal to

the num_char argument.

Example:
mid("Paris, New York",8,8) = New York

pad ( «string», «length», «char»): Adds characters to the left of the field to assign a predefined length to the

whole input. Any character can be selected as a padding character.

Example:
If a field named GREETING displays a value HELLO, then:

pad(GREETING,8,0) = 000HELLO
pad(5,3,0) = 005
pad("Nine",6,"a") = aaNine

replace («string», «start», «xnum_char», «<new_string»): Returns the converted string argument. A number
(equal to the num_char argument) of characters from the position defined in the start argument has been replaced

by the new_string argument.

Example:
replace("Paris, New York",8,8,"Singapore") = Paris, Singapore

replaceString («string», «old_string», «xnew_string»): Replaces all occurrences of a specified «old_string» in

character string «string» with another specified «new_string».
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Example:
ReplaceString( "abcl12def12", "12", ") = abcdef

rept («string», «num_char»): Returns the character string where the string argument is repeated the number of

times in the num_char argument.

Example:
rept("Ah Paris! ",2) = Ah Paris! Ah Paris!

right («string», «<num_char»): Gives the character string composed of the last characters of the string and has a
length equal to the num_char argument.

Example:
right("Purchase order",5) = order

RTrim («string»): Will automatically trim off any trailing spaces or leading spaces to the right data.

Example:
RTrim("Part ") :Part

search («string», «key, start»): Gives the position of the first occurrence of the key argument in the string
argument. The search starts from the position defined by the start argument (start >= 1). The function resets to
zero if no occurrence of the key argument is found.

Examples:
search("Purchase order","order,1) = 10

search("Purchase order","c",1) = 4

StrAfter(«data»,«start after», «length»): This function results in a string that is exactly length characters long

after a specified start after character.

Examples:
StrAfter("1234-5678", '-', 3)= Takes the 3 characters after the dash (567)

StrAfter("1234-5678", '-")= Takes all characters after the dash (5678)

StrBefore(«data»,«start before», «length»): This function results in a string that is exactly length characters

long before a specified start before character.

Examples:
StrBefore("1234-5678", '-', 2)= Takes the 2 characters immediately before the dash (34)

StrBefore("1234-5678", '-')= Takes all characters before the dash (1234)

SuppressBlankRows («string»): Returns a string with skipped empty lines. It allows you to create an object and

place the fields you want within and suppress the ones that are blank.
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Example:
SuppressBlankRows({Var0} & char(10) & {Varl} & char(10) & {Var2}) (VarO, Varl and Var2 are variables,

char(10) is "\n" symbols that mean new line)

Variables/Values Formula Result

Var0 = "Doris" Doris
Varl = "Bull Run Ranch" SuppressBlankRows({Var0} & char(10) Bull Run Ranch

& {Varl} & char(10) & {Var2})

Var2 = "Aurora" Aurora
VarQ = "Craig" SuppressBlankRows({Var0} & char(10) Crai
Varl ="" & {Varl} & char(10) & {Var2}) Chic% o
Var2 = "Chicago" g
m z "E:ra|g {Var0} & char(10) & {Varl} & Craig
Var2 = "Chicago" char(10) & {varz} Chicago

trim («string»): Returns the converted string argument. All spaces encountered at the beginning and end of the

string are deleted. The number of spaces included between two words is reduced to one.

Example:
trim(" Purchase order") = Purchase order

trimall («string»): Returns the converted string argument. All spaces encountered are deleted.

Example:
trimall("Paris / New York / Rome") = Paris/NewYork/Rome

upper («string»): Gives the string converted into upper case.

Example:
upper("Purchase order") = PURCHASE ORDER

ztrim («value»): Deletes the zeros from the left side of the numerical value. Fields are entirely numerical.

Example:
If a field named WEIGHT displays a value of 000200, then:

ztrim(weight) = 200

Defining the properties of a Formula data source

Command: Data sources > Formula > formulaname > Properties

1. Enter the formula directly in the Edit field.
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Select the elements, and click Insert.
2. Click OK.
Hint: You can insert an element by double-clicking on it.

Note: If a variable used in the formula has a name containing one of the following characters &+-*/<>="%,!\", it must be
enclosed in brackets {}.

Note:Dynamic preview represents current formula calculation result, including the formatting defined in Output page. In case of
error, the preview is displayed in red. If the value obtained is truncated, you must modify the maximum length specified in the
Output tab.

Exercise: Creating a specific modulo

Your software comes with integrated modulo calculation functions for generating barcode check characters.

However, it may be that you need to calculate a specific check character, and, as a result, the integrated functions

do not meet your requirements.

You will thus need to create the function yourself. In the next sequence we will see how it is possible to use

formulas to create any kind of check character calculations.
This example illustrates how a control character can be calculated for a 2/5 interleaved barcode.

Method for calculating a check character

The method involves multiplying the first character of the data string by 1, the second by 2, the third by 1, and so
on.

« Open the label named CHECKO1.LAB located in the TUTORIAL folder.
The check character calculation will be carried out on the LOT_NUMBER (26053) data.

To calculate the weight

1. Click on the Formula branch of the Data Sources view, and add a new Formula.
2. Enter the following formula:

mid (LOT_NUMBER,1,1) &

mid (LOT_NUMBER,2,1) *2 &

mid (LOT_NUMBER,3,1) &

mid (LOT_NUMBER,4,1) * 2 &

mid (LOT_NUMBER,5,1)

The result is 2120103, as we have:
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2*1=2
6*2 =12
0*1=0
5*2 =10
3*1=3

The concatenation of the results gives 2120103.
3. Name the formula "WEIGHTED".

To add up the result of the weight calculation:

The next step involves adding together the figures resulting from the previous formula, bearing in mind that the

maximum permitted length of this character string is 2.

Create a second Formula, and name it "SUM”.

2. Enter the following expression in the text box:
mid (WEIGHTED,1,1) + mid (WEIGHTED,2,1) +
mid (WEIGHTED,3,1) + mid (WEIGHTED,4,1 )+
mid (WEIGHTED,5,1) + mid (WEIGHTED,6,1) +
mid (WEIGHTED,7,1)

The result is 9; as we have:
2+1+2+0+1+0+3=9.

To calculate the check character:

Using the previous result, we will calculate the value of the check character.

Create a third Formula, and name it "CHECK_DIGIT".
2. Enter the following expression in the text box:
if ((SUM % 10) > 0,10 - SUM % 10,0)

The result is 1; as we have:
SUM % 10 = 9 (% = modulo).

9 being greater than 0, we carry out the subtraction: 10- 9 = 1.
Note: If the result had been equal to 0, the value of the check character would have been 0.

To calculate the data to be encoded:

When creating the barcode, you must include the data to be encoded; for example, the value of the
LOT_NUMBER variable concatenated with the value of the check digit (CHECK_DIGIT).

1. Create a fourth formula and name it DATA.

2. Enter the following expression in the text box:
LOT_NUMBER & CHECK_DIGIT.
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To create the barcode:

1. Click the Barcode tool on the design toolbar. Next, select he DATA formula, then drag and drop it onto
the label.

2. Select the barcode, right-click on it and choose Object properties. from the context menu. The Barcode
dialog box appears.

3. Configure the barcode as follow:
Symbology: 2/5 Interleaved
Check Digit: None
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Installing the network version

Description

To use the network/multi-user version of your Label Design Software, you must first install Network License

Manager, either on the server or on a workstation that will act as the server, then install your labeling software on

each workstation.

Installation of Network License Manager

- E— & . |
ENver

orkstation Workstation

Installing the dongle

The dongle must be installed on the computer (server or workstation) on which the license service is installed. A

single dongle, pre-programmed with the number of licenses purchased, is included with the network version of

your software.
The dongle must be installed before the license service can be started.

Note: When you start the program, if the dongle does not match the product version, a dialog box with the necessary

instructions is displayed.

If you need to use a printer on the parallel port, connect it to the dongle. In this case, you might have to turn the

printer on in order for the dongle to be recognized.
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Network Installation procedure
Network configuration

Before you install the software, the network administrator must first define the structure of the network for the

group of users:

e Define the license server on which the Network License Manager and dongle will be installed.

e Define the workstations, or the client workstations that will use the labeling software.

Description of Network Manager

The Network License Manager lets you use the network configuration of your labeling software. The Network

License Manager includes:

e The Network License Manager (License Service).
o Network Settings Wizard: The Network Settings Wizard helps you define the network configuration.

e User Manager: The User Manager is installed with the Network License Manager so you can define

access rights to the labeling software in a network setting.

Installing the Network License Manager on the server

Before installing the labeling software on all the workstations that will use it, you must install the Network License

Manager on the server to configure the network.

1. Insert the DVD for the installation in the appropriate drive.

The Installation window is displayed.

If the DVD for the installation does not run automatically:
Go to Windows explorer and expand the letter of the DVD drive. Double click on index.hta.
2. Select Network License Manager, which includes License Service, and User Manager. Then click the
Install button.
Follow the on-screen instructions..
4. Share the [TKDONGLE] folder with full control, using TKDONGLE as the share name.

The default access path for this folder is: C:\ProgramData\TKI\LicenseManager\TKDongle)

> RIGHT CLICK > Properties > Sharing tab and Permissions button.
5. If you want to define settings for your network configuration, start the Network Settings Wizard on the

server. By default, if you do not modify the configuration, each workstation will have its own settings.

Note: For administrators: You can grant Write access to the network license by completing the following two steps:
1. Sharing the TKDongle folder and authorizing the user: C:\ProgramData\TKI\LicenseManager\TKDongle

> RIGHT CLICK > Properties > Sharing tab and Permissions button.
2. Give Write Access to the user in the Security tab of the TKDongle properties.
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Configuration

All the necessary tools to configure the network version are available from the Network tool bar, which can be

accessed from:

Start > Programs > TEKLYNX Network License Manager > Network Toolbar.

The Network Settings Wizard helps you define the settings for your network version.

To start the Network Settings Wizard, click on the icon %I

In step 1 of the wizard, select a settings mode: Generic, By user or By station.

NP

e Generic: All users will use the same settings on all workstations. (user.ini).
e By user: Each user can access his or her own settings on any workstation. (user name.ini).

e By station: Each workstation has its own settings (station.ini).

3. In step 2, specify the location in which you want to store these settings. If you want to share these
settings between various workstations, specify a network path that is accessible to all workstations.
4. In step 3, specify the location in which you want to store the shared data (variables, lists, printing logdfile,

etc.).

To configure the User Manager

If you want to define network access rights for all users of the labeling software, you must do so during installation
(consult the User Manager help system). Click the User Manager icon available on the Network toolbar.

Starting the License Service

Before installing the labeling software on all workstations, you must be sure the License Service is started.

The License Service was installed as service called SLicense. You do not need to start it. In fact, SLicense starts

when the workstation is turned on and runs as a background task as long as the workstation is on.

To start the License Service Controller

e Click the icon@ available on the Network toolbar.

e  Double-click the SLICENSECTRL.EXE file in the installation folder.
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Installing the software on the workstations

The labeling software must be installed on all the workstations on which it will be used.

To install the software on a workstation

1. Insertthe DVD in the appropriate drive.

The Installation window is displayed.

If the DVD does not run automatically:
Go to Windows explorer and expand the letter of the DVD drive. Double click on index.hta.
Select the product to be installed, click the Install button and follow the instructions on the screen.
3. Start the labeling software. A message is displayed to inform you that no dongle has been found. Click
Yes to start the software.
4. From the menu, choose Tools > Network Administration.
Enable Use Network License.
Click Modify to select the server on which the license manager and dongle are installed.
-or-

Click Browse to automatically search for the server on which the license manager is installed.

If the network has already been configured, a message asking if you want to use the current network
configuration is displayed.

7. If you want to modify or configure the network settings, click the Network Settings Wizard button.
Click OK.

9. Restart the program.

50



Installing the network version

Setting the Standard

TEKL

BAR CODE SOFTWARE

France Germany Singapore United States
+33(0) 562 601 080 +49 (0) 2103 2526 0 +65 6908 0960 +1 (414) 837 4800

Copyright 2018 Teklynx Newco SAS. All rights reserved. TEKLYNX, CODESOFT, LABEL ARCHIVE and SENTINEL are trademarks
or registered trademarks of Teklynx Newco SAS or its affiliated companies. All other brands and product names are trademarks and/or
copyrights of their respective owners.

www.teklynx.com A
Microsoft Partner

Independent Software Vendor (ISV)
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